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Introduction to 
PageMaker 6.5 

 
 

INTRODUCTION 

Adobe PageMaker 6.5 is the “world’s leading cross- platform professional page 
layout software”. PageMaker is primarily used for designing and producing publication that 
requires a combination of text and graphics. PageMaker 6.5 has a rich  array of facilities to  
import text and artwork from other computer application packages, as well as allowing you to 
generate these directly from within PageMaker itself. PageMaker can handle text better than 
Illustrator and PhotoShop and also give you the flexibility of graphic control not available in 
world processors 

 

NEW FEATURES IN PAGEMAKER 6.5 

DOCUMENT LAYERS 

Layers allow you to place elements on over the other. It  can be thought of as  
sheets stacked up one on top of the other. You can place elements on these layers or temporarily 
hide the layers. These layers can be used for adding imitations, floating or background images. 

 

EASIER LAYOUT 

There is a new concept of frames in PageMaker 6.5, which can hold any type of 
text or images. PageMaker’s freeform layout capabilities have become even more flexible with  
its frame and text controls. 

 

BETTER INTERGRATION 

PageMaker can work seamlessly with PhotoShop, Illustrator etc. It also builds the 
ability to drag and drop images and elements directly from one of these applications to the other 

 

COLOR CONTROLS 

PageMaker 6.5 introduces new color technologies, which helps in reproducing high 
fidelity colors in you publications. A new desktop color separation tool is also included.  The 
Kodak color management system now supports the international Consortium of Standard   for 
sharing device profiles. 
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INTERNET READY 

The current release of PageMaker (i.e. Version 6.5) includes an option to export 
your PageMaker documents to Internet ready HTML (Hyper Text Markup Language) files with 
the links preserved. The document images are converted to GIF or JPEG format required by the 

 

Basic of PageMaker 
 

PAPER ORIENTATION 
 

You can set paper in two ways, portrait is one in which the paper is used with the 
longer size in the vertical direction. If we interchange the directions, we get the Landscape 
orientation. 

 

Lands cape 
 

STARTING PAGEMAKER 

 Click the Start button. 
 

 Select Programs. 
 

 From the Programs Menu select Adobe. 
 

 In the Adobe Menu select PageMaker 6.5. 
 

 Click adobe PageMaker 6.5. 
 

 The PageMaker window is displayed. 
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PAGEMAKER ENVIRONMENT 
 

Menu Bar: 
 

The standard menu bar contains all the main menus for File, Layout, Element and 
other utilities. 

 
Ruler: 

 
The top and left ruler bars helps you to precisely position the cursor, text, and 

graphics in the page. The Current Cursor location is shown by two dotted lines in the rulers. The 
view the rulers select View > Show Rulers. 

 
Master Page Icon: 

 
The Master Page icon showed the position of the master Pages. Clicking it will 

display the Master Page. Master Pages contain text, graphics, layout and settings, which are 
common, thought the publication. 

 
Page Icon: 

 

The Page icon shows the list of pages in the publication with the currently selected 
pages in black. Clicking a particular page icon will display the selected page. 

 
Plasterboard: 

 
Surrounding the page is an area of white space called the Plasterboard. It is used to 

store graphics and texts as you work. Items you place on the plasterboard are visible from any 
page and can be selected and moved regardless of the page you are currently working on. 
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FILE MENU 

New: New command is used to create a new publication. This command gives  
rise to a dialog box where you define the various options before opening a new page of the 
publication. 

 

Open: Open allow you to open an existing PageMaker file. 
 

Save: Save command saves the current publication. To save all the open files, 
press the shift key while choosing the Save option. 

 
Revert: Revert command rolls back all the changes made since the last save. It is 

the same as closing the publishing without saving and opening it again. 
 

Place: Place command is used to place text and graphics into the publication. 
 

Acquire: The Acquire command is used to scan an image into your publication. 
 

Export: Export command lets you export you publications into the format you 
select. 

 

 

EDIT MENU 

Paste Multiple: Paste Multiple lets you paste multiple copies of text or 
graphics.  

Paste Special: Paste Special is used to specify the format to use when you paste 
an object into your publication. 
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Insert Object: Insert Object is used to specify the format to be used to insert an 
OLE embedded object within a PageMaker publication. 

 
Edit Story: Edit Story is used to toggle between the word processing mode and 

the layout mode. 
 

 

LAYOUT MENU 

Sort Pages: When you select Sort Page command, a dialog box appears with all 
the pages of the publication. You can rearrange the pages in the publication graphically. 

 
Column Guides: Column Guides lets you divide the pages of the publication 

into different column of equal size. 
 
 

Auto Flow: Auto Flow is used to flow the text onto the pages of the publication 
on its own from a loaded text icon. It flows  the text into pages from columns to columns and  
also adds pages on its own depending on the availability of text. 

 



8  

 

TYPE MENU 

Define Styles: This option will present you a dialog box with the list of styles 
used in the publication. You can add, modify and delete styles from this dialog box. 

 

 

ELEMENT MENU 
 
 
 

 
other. 

Frame: Frame has options for frame alignment, position and margins. 
 

Align Objects: Align Objects  lets  you  align  multiple  objects  relative  to each 

 

Link Options:  Link Options is used to define whether the linked text or graphic 
is to be updated along with the publication in use and also its frequency. 
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UTILTIES MENU 

 

Plug-ins: Plug-ins has a list of sub commands, which lists out the various plug- 
ins, which have been included with PageMaker as additions. 

 

 

VIEW MENU 

Display Master Items: Display Master Items toggle the display of items from 
the master pages to be reflected in the current page of the publication. 

 
Display Non-Printing Items: Display Non-Printing items toggle the display 

of non-printing items. 

 
 

WINDOW MENU 

Show Tools: Hide/Show tools toggles the display of PageMaker toolbar. 
 

Show Control Palette: Show/Hide Control Panel toggles the display of 
control panel on the screen. 

 
Show Colors: Show/Hide Colors Toggles the display of the Color Palette on the  
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screen. 
 

 
screen. 

Show Style: Show/Hide Styles toggles the display of the Styles Palette on the 

 

Show Layers: Show/Hide Layers toggles the display of the Layers Palette on the 
screen. 

 

Show Master Pages: Show/Hide Master Pages toggle the display of the Master 
Pages Palette on the screen. 

 
Show Hyperlinks: Show/Hide Hyperlinks toggles the display of the Hyperlink 

Palette on the screen 

 
 

UNDERSTANDING PAGEMAKER TOOLS 
 

TOOL BOX 

Toolbox contains all the tools used to create a publication in PageMaker. Choose 
Window and select Show Tools to display the toolbox. The individual tools will be explained in 
detail later in this session. 
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ZERO POSITION 

Zero Position allows you to set the zero position on the screen. Zero position is the 
position, where both the top and the left side rules are at zero. By Zero positioning all 
measurements in the pages are made relative to this point. Click it and drag  it to anywhere on  
the workspace to set it as the Zero Point. 

 

 

POINTER TOOL 

Pointer tool is used to pick, drag and drop graphics and text. 
 

TEXT TOOL 

Text Tool is used to edit and select text and insert text frames. Click the text tool 
and click anywhere in the document and start entering text. The text tool creating a free flowing 
text box. 

 
 

ROTATE TOOL 

Rotate too is used to rotate text and graphic objects. Click the rotate tool. Then 
click on the object reference point and drag to rotate the object. 
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CROP TOOL 

The Crop tool is used to crop imported graphic images to the required size. The 
crop tool only works on TIFF type of images. Click on the toll and, drag the image handles, to 
crop the image. 

 

 

OBLIQUE LINE TOOL 
 

Oblique Line is used to draw slanting lines. To draw a line, click the oblique line 
tool, click and drag to draw a line in any direction. 
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CONSTRAINED LINE TOOL 
 

Constrained Line tool will draw lines at 45 degree intervals, i.e., horizontally, 
vertically or diagonally. 

 

BOX TOOL 

Box tool is used to draw a box. 
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RESTANGLE FRAME 

Rectangle Frame is used to type text inside a box. First select the toll and draw the 
area to be enclosed by the rectangular frame, then select the text tool and click inside the drawn 
frame to enter text. The text will be constrained to the rectangular frame. 

 

 
CIRCLE TOOL 

 
Circle tool is used to draw a circle or elliptical graphic. To draw a circle or an 

ellipse, select the tool, click and drag to draw a circle on the document. 
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CIRCULAR FRAME 

Circular Frame is used to type text inside a circle or an oval. Use the Circular  
frame tool to draw the frame and then click inside with the text tool to start entering text. The 
entered text will be constrained to the circular frame. 

 

 

POLYGON TOOL 

Polygon tool is used to draw a shape with more than four sides. You can modify  
the polygon by selecting Element and selecting Polygon Settings. 
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POLYGON FRAME 
 

Polygon frame puts the text inside the polygon. Select the polygon frame tool,  
draw a polygon then select the text tool and click inside the frame to enter the text inside the 
frame to enter the text inside the polygon frame. 

 

 

HAND TOOL 

Hand tool is used to move the screen. This tool is very useful when you are 
working with large documents. It helps you to easily navigate in a large page. To move a screen, 
just select the hand tool and click and drag the page to view different parts of the page. 
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ZOOM TOOL 

Zoom tool allows you to zoom in and out of the document view. By default the 
zoom tool will be in the Zoom-in mode. To zoom out of page select the zoom tool and press 
control and click in the document window with the zoom tool. 

 

 

OPENING A NEW PUBLICATION 

 Click File. 
 

 Select New. 
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The Document Setup dialog box appears. Enter 2 in the number of pages text box 
and press the TAB key. 

 

 

 

 Enter 1 inch as the inside margin and press the TAB key. 
 

 Select the printer “HP Deskjet on LPT1” 
 

 Click OK. 
 

A new document is opened with the required margins and the first page of the 
selected document is display 
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PAGE SIZE AND PAPER SIZE 
 

Paper size is the actual size of the paper and Page Size is the printable area of the 
page. The Page size is the area enclosed by the page margins. 

 

CONTROL PALETTE 

The control Palette displays the properties for the selected paragraph, character or 
object. It is a sort of shortcut to the object, text, and paragraph properties. Choose Window and 
select Show Control Palette to display the Control palette. 

 

 

Control Palette in Object Mode 
 

The control Palette when it has an object selected displays the object properties 
such as the reference point, position, size, scaling. Cropping, printer  resolution,  rotating, 
skewing and horizontal and vertical reflection. 

 
Horizontal/vertical mirror: Mirrors the currently selected object along the x 

or y-axis.  
Height/width: sets the height and width of the currently selected object, either 

numerically in inches or in percentage of the current size. 
 

Rotate: Rotate, is used to rotate the selected object around an axis. The center of 
rotation is set as the object’s center and exact measurements can be used. 

 
Skew: This skews. The currently selected object, in degrees. 

 
XY position: sets the horizontal and vertical position of the upper-left comer of 

the currently selected object. 
 

 

Control Palette in Character Mode 

The Character Palette is displayed when the text tool is selected. It has options for 
changing text styles, size, leading, tracking, width and Deming. There is a toggle button to shift 
between paragraph view and character view. 
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Kerning: Text Kerning adjusts the spacing between characters in text. It is 
selective, so you can adjust just one or two characters, or whole sections of text, Negative 
numbers move characters closer together, whereas Positive numbers space them out. 

 
Leading: Text Leading adjusts the spacing between lines of text. This is 

applicable on line-by-line basis. Positive and Negative number have the same effect as they have 
on Kerning, except that the spacing is between the lines of text. 

 
Tracking: Text Tracking adjusts how closely characters follow each other. Very 

tight tracking brings text closer together, very loose spreads it out a bit. 
 

Size: Text Size adjusts point size of text. 
 

Position: Text Position adjusts the placement of the text on a given line. Positive 
Numbers move the text into a super text position (above the line), and Negative numbers move   
it into a subtext position (below the line). 

 
Width: Text Width adjusts the character width and does not affect height. The 

larger the percentage, the wider the word. Percentages over 100% make it proportionate larger 
than standard sizing, fewer than 100% make it proportionate smaller. 

 

 

Control Palette In Paragraph mode 

The control palette displays options for the paragraph style, alignment, indents, 
spacing, grid spacing and grid alignment. 

 

 

COLOR PALETTE 

The Color Palette is used to apply colors or view the name or kind of color applied 
to the selected text or object. The buttons stroke, fill or both, can be used to change the color of 
the graphic object and Object level. Tints allow you to have variations of the same color. To 
apply a color to a text or object and select the color from the color Palette. Choose Window and 
select Show Colors, to display the Colors palette. 
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STYLES PALETTE 

The Styles Palette is used to apply styles or to view or edit styles defined for the 
publication. To apply a style, just click a paragraph with the text tool and then click a style name 
in the palette. Choose Window and select Show Styles to display the Styles palette. 

 

LAYERS PALETTE 

The Layers Palette is used where a multiple layers document structure is required. 
Layers allow you to separ4ate the different elements that make up your document. You can hide, 
display, add or delete layers as required. Choose Window and select Show Layers to display the 
Layers Palette. 
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MASTER PAGES PALETTE 

The Masters. It displays a list of available master and apply masters pages for a 
particular document. The master page icon at the bottom of the window is used when you  want 
to go to a master page for editing. Choose Window and select Show Master Pages to display the 
master Page palette 

 

 

HYPERLINK PALETTE 
 

A hyperlink has two parts: a source, which is the hyper linked text, or graphic that 
you click, and a destination, which is where the source jumps. Inside a PageMaker Publication, 
destinations are called anchors. You can also give a valid web hyperlink. Choose Window and 
select Show Hyperlinks to display the Hyperlinks palette. 

 

 

SETTING A MEASUREMENT SYSTEM 

 Click File 
 

 Select Preference. 
 

In the Preferences menu select general. 
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GRIDS, RULERS AND GUIDES 
 

GUIDES  
 
Margin Guides: Margins are defined in the Document Setup dialog box, when 

you first create a publication, and are applied to the Document Master page. These are 
represented by pink lines on the top and bottom and by blue lines on the left and right. 

 
Column Guides: Column guides serve as boundaries for text you place within 

them. You can have as many as 20 column per page. Column guides control the flow of text and 
represented by dark blue lines. 

 
Ruler Guides: Ruler Guides are also nonprinting guidelines which primarily 

used to align. Objects in the publication and are represented on the screen by Light blue lines. 
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VIEWING PAGES 

Zoom In: Zoom in Magnifies the Document to the next level 
 

Zoom Out: Zoom out Shrinks the Document view the previous level 
 

Actual Size: Actual size Displays the entire page or a two page spread within  
the publication window. 

 
Fit in Window: Fit in window will display the current page in its entirety  

within the publication window. This view is especially useful to check the layout of the page. 
 

Entire pasteboard: Entire pasteboard displays the page with the entire 
pasteboard so that you can find or view objects. 

 

 

INSERTING PAGES 

 Click Layout. 
 Choose Insert Pages. 
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SORTING PAGES 
 

 To change the page order Click Layout. 
 

 Select Sort Pages. 
 

A dialog box with the page icons appears. Click on the fourth page, and place it 
before the first page. 

 

 
 Click OK to close the dialog box. 

 
 The Page is rearranged and the page numbers are changed accordingly. 

 

CREATING NEW DOCUMENT 
 

MASTER PAGES 

Master Pages are a sort of a template for all of the pages in a publication. The 
Master pages can contain text, Graphics and guides. These are reflected in all the pages of the 
publication. They generally contain logos and volume title, which are to be repeated in every 
page of the publication and also guides, which help to maintain uniformity throughout the 
publication. 
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CREATING A NEW MASTER 

 Click Window. 
 

 Select the Show Master Pages Palette from the window menu. 
 

In the Master Pages Pallet Click on the Top right arrow to display the Palette 
Menu. 
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Working with Text 

TEXT BASICS 
 

ENTERING TEXT 

In Page Maker, text is typed in text blocks or frames. Text blocks are defined by  
the amount of text and the margins of the page. 

 
 To open a text block First click the Text tool. 

 

 Click anywhere on the page within the margin guides. 
 

 Press the mouse button and drag the insertion point to the right. Release the 
mouse when you have opened the box to the correct size. 
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PLACING TEXT 

 Click on Edit menu. 
 

 Select Edit Story. 
 

 Type “Demo for Placing Tex “. Click on Story. 
 

 Select Close Story. 
 

Page Maker displays an alert message that says, “The story has not been placed.” 
Click the place button to place the story. 

 

 
Page Maker displays a loaded text icon. Click the icon to flow text into the frame  

or column you click on. 
 



27  

TEXT OBJECTS, STORIES AND EDITORS 
 

Understanding test objects and stories: Text in PageMaker is part of a 
story. A story can be a single letter or several page of text and can be contained in a single text 
object or threaded through many different objects. 

 
Layout Editors and Story Editors: Text blocks that are threaded together  

in the Layout Editor comprise the same story in the Story Editor. A text block may be  split 
among several pages in the Layout Editor, but it appears as a continuous story in the Story  
Editor. 

 

FORMATTING TEXT 

Changing Font Sizes: In PageMaker, by default the type size is 12 points but 
you can change the size as often as you like using the Control Palette. The Control Palette  can  
be activated or deactivated from the Window menu. 

 
Changing Typeface Styles: There are ten different styles for any typeface. 

They are Normal, Bold, Italic, and Underline, Reverse, and Strikethrough, Small caps, All caps, 
Super script and Sub script. 

 

 

Changing Character Specifications: The Character Specifications dialog 
box allows you to choose several type attributes in one step. This dialog box can be opened by 
double clicking the Text tool. 
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KERNING AND TRACKING  

PageMaker provides three types of kerning. 
 

Automatic pair kerning: Automatic pair kerning adjusts the space between 
certain character pairs, based on the kerning information that’s built into the font. 

 
Manual kerning Manual: Kerning lets you kern any range of text, from one 

character pair to a whole story, using cursor keys or by using the Control palette. 
 

Expert kerning: Expert kerning calculates a manual kerning value for every 
character pair in a selected range of text. 

 

TRACKING 
 

Tracking is similar to kerning in that it deals with the horizontal space between 
letters. PageMaker includes five built-in tracks from Very Loose to Very Tight. To set the 
required track, first select the text. 

 

PARAGRAPH SETTING 

Paragraph formatting includes setting indent values, paragraph spacing, text 
alignment, dictionary, etc. in this exercise we shall see how to draw a line below a paragraph. 
Click on the Text tool. 

 
 Select the Text paragraph. 
 Click on the Type menu. 
 Select Paragraph Options 

 

SETTING TABS 

In this exercise we shall see how to set tabs. 
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 Select the Text tool. 
 

 Click on the Type menu. 
 

 Select Indents/Tabs. 
 

Drag the first half of the left indent to 1 inch. 
 

 
Drag the right indent by 1 inch. 
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Click OK. 
 

Thus the paragraph has been aligned according to the Indents set. 
 

 

BULLETS AND NUMBERING 

THE Bullets and numbering option automatically adds bullets or numbers to the 
paragraph in the text block. To edit bullets or to add numbers you can click the Edit or Numbers 
button respectively. 
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HYPHENATION SETTING 

PageMaker hyphenates words to reduce the spacing between them in a justified 
text. Hyphenation is controlled with the hyphenation dialog box. 

 
The Manual only option hyphenates only the wor4ds that you have marked to 

hyphenate by inserting a discretionary hyphen in the word where it would normally break. 
 

Manual plus dictionary option hyphenates the words to which you have added 
discretionary hyphens, as well as words hyphenated in the PageMaker dictionary. 

 

 
In addition to using the dictionary, Manual plus algorithm option, uses a 

mathematical algorithm and your manually inserted hyphens to break words. 
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Hyphenation Setting 

 Let use see how to add a word to the user dictionary. Click on the Type menu. 
 

 Select Hyphenation. 
 

 Click the Add button in the Hyphenation dialog box. 
 

 In the Add to User Dictionary dialog box type Lay~out~ Galaxy. In this word, 
h\the most favorable break is marked by a single tilde (~) and the second most favorable break is 
marked by a double tilde. Click OK to close the Add to User Dictionary dialog box. 

 
 Click OK to close the Hyphenation dialog box. 

 
 The word “LayoutGalaxy” has been added to the Dictionary. 

SET STYLES 

In this demo we shall see how set style 
 

 Select the Text tool. 
 

 Click the insertion point anywhere in the text. 
 

CREATING STYLES 

 To create a new style click on the Type menu. 
 

 Select Define Styles. 
 

 In the Define Styles dialog box, Click New button. 
 

Style Options dialog box opens. In the Name text box type “MyStyle”. 
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ROTATING TEXT 

Let us see how to rotate a text frame. Click the arrow tool. 
 

 Select the text 
 

 Type 45 degrees and press Enter. 
 

The frame has been rotated by 45 degrees. 
 

 
ADDING COLOR TO TEXT 

 
In this Exercise, we shall see how to change the color of a text. 

 
 Select the text. 

 
 Click on the Window menu. 
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 Select Show Colors. 
 

 Select blue from the Colors Palette. 
 

 The Text Color has been changed to blue. 
 

ADVANCED TOPICS 

CREATING HYPERLINKS 

Let us create a hyperlink. Click on the File menu. 
 

 Select New. 
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 Document Setup dialog box opens. Click the Page Size Pop-up menu. 
 

THREADING 

When a story in a text block extends to the next or subsequent pages, it is broken  
up into individual page text blocks. A small Red triangle in the lower window shade handle 
indicates that there is more text that can be currently displayed in the text box. Click on the Red 
triangle to display the second block of the text. 

 

 
The pointer will turn into a loaded text icon. Click to place the second block. The 

small + symbol in the top window shade indicates that the story has been continued form a 
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previous block text. An empty handle in the bottom window shade indicates the end of  the  
Story. 

 

 

SPELL CHECK 

PageMaker helps you in proof-reading your text by providing a ‘Spelling  
Checker’, which can be used to check the spelling for a selected range of text or for  all the text  
in the active story or all stories in all open publications. PageMaker will warn you of any words  
it cannot locate in its dictionary. If any word is misspelled then you have the choice to re-enter it 
or choose form a selection of closest matches in the dictionary. The spelling dialog box can be 
activated from the Utilities menu. 
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WORKING WITH COLUMNS 
 
 

PageMaker allows you to divide any page into columns. In this exercise we shall 
split a page into Columns. Click on the Layout menu. 

 
 Select Column Guides. 

 

A Columns Guide dialog box appears. In the Number of columns dialog box, type 
2. 

 
 

 Click OK to close the dialog box. 
 

We can now see the pages split into columns. 
 

 

INDEXES AND PAGINATION 
To create an Index, Click on the Edit menu. 

 
 Select Edit Story. 
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Click the loaded text icon anywhere on the page. Now you have added, “adjust 
layout” to your Index. Similarly you can add other words. 

 

INDEXES AND PAGINATION 
 

The Sort Page feature can be activated from the Layout menu. This feature allows 
you to re-order the pages in your document. This can be easily done by dragging the page 
thumbnail images around, within the window. Changing the order of pages does not alter  the  
text in a story. The story remains intact even though text objects may have moved to different 
pages. 
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USING THE FIND FEATURE 

Using the find and change feature, you can search for specific occurrences of a 
wont or group of words. Once you find what you’re looking for, then PageMaker automatically 
changes it to the selected option. The find and the change dialog boxes can be activated from the 
Utilities menu. 

 

 

Working with Graphics and Layer 

GRAPHICS 

LINE TOOL 
 

In this exercise, you will learn to use the Line Tool. 

Select the Line Tool from the Tool Box. 

Pointer the Cursor on “A” and hold down the mouse Button and drag it to Point 
“B” and the release the mouse Button. 
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Now you can see a line drawn on the Screen. 
 

 

BOX TOOL 

Box tool is used to draw both rectangles and squares. In this exercise  you  will 
learn to use the Box Tool. 

 
 Select the Box Tool. 
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Point the Cursor on A and hold down the mouse Button and drag it to Point B and 
release the mouse button to draw a Rectangle. 

 

 
Now Draw a Square using the Box Tool. Point the Cursor on C and hold down the 

Shift Key and drag the mouse button down to Point D to draw a Square. 
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ELLIPSE TOOL 

Ellipse tool is used to draw both Ovals and Circles. In this exercise, you will learn 
to use Ellipse Tool. 

 
 Select Ellipse Tool. 

 

Point the Cursor on A and hold the mouse button down. Drag it to Point B to draw 
an Oval. 

 



 

 

Now draw a Circle using an Ellipse Tool Point the Cursor on C and hold down the 
Shift key and drag the mouse button down

 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

POLYGON TOOL 

In this exercise, you will learn to use the Polygon Tool
 Select the Polygon

Now draw a Circle using an Ellipse Tool Point the Cursor on C and hold down the 
Shift key and drag the mouse button down to Point D to draw a Circle. 

In this exercise, you will learn to use the Polygon Tool 
Select the Polygon Tool. 

43 

Now draw a Circle using an Ellipse Tool Point the Cursor on C and hold down the 
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Point the Cursor on A and hold down the mouse Button and drag it to Point B and 

release the mouse button to draw a Polygon Tool. 
 

 
 

Click Element menu. 
 

 
Select Polygon Settings. 
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In the Polygon Setting dialog box, enter 40 for the number of Sides and press the 
Tab Key. 

 

Enter 30% for star inset and Press the Tab Key .Click OK. 
 

 

In this way you can modify a Polygon in to a star having 40 Sides and 30% Star 
inset. 

 
 

ROUNDED COLORS 

In this exercise you will learn how to round the corner of a rectangle using 
“Rounded Corners” option. 

 
 Select the Pointer Tool. 

 
 Click the Rectangle to select it 

 
 Click Element menu. 
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 Select Rounded Corners. 
 

The Rounded Corners dialog box appears on the Screen. From this dialog box 
select the last Option. 

 

 
 Click OK. 

 
Click anywhere outside the rectangle on the screen 

 

 

You can now see the change in the corners of the rectangle. You can also modify a 
square in the same way. 

 

FILL 

The Fill command is used to fill the box or circle with the options available under 
this command, which consists of various types of lines along with the options like paper and 
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solid. If you choose the paper option, the object fill changes to the background paper color and 
when the solid option is chosen, the object gets completely filled 

 

 
STROKE 

 
You can use the stroke command to select the lines of different sizes and styles or 

choose the option called custom to create the line of your own style. Besides these, you have   
two more options called. Transparent and Reverse. Use Transparent Background option if you 
want the objects placed behind a patterned stroke to be shown through the spaces in the pattern 
otherwise the spaces in the pattern are opaque. Reverse Stroke option is used to draw a paper- 
colored stroke or outline of a shape on a contrasting black, shaded, or colored background. 
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FILL AND STROKE 

This is the combination of the above two commands. Instead of selecting them one 
by one, you can select them together with this command. 

 

 

PLACING GRAPHICS 

The Place command is used to Import Graphics. In this exercise you will learn 
placing a Graphic. To do this you first click the File menu. 

 
 Select Place from the drop down menu. 

 
The Place Dialog Box opens up. Double Click “Bouquet.tif”. 
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You can now see the imported image on your screen. 
 

 

TRANSFORMING OBJECTS 
 

TRANSFORMING A RECTANGLE 

In this exercise you will learn to transform a rectangle. 
 

 Select the Pointer Tool. 
 

 Click the Rectangle to select it. 
 

Now you can see the change in Control Palette at the bottom of the work area  
using which you can transform the rectangle. In the Control Palette change the Rotation to 25 
degrees and press the Tab Key. 

 

 

Change the Skew angle to 25 degrees and Press the Tab Key. Click the width 
column 
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Change the width to 5 inches and press the Tab Key. 
 

 
Change the height to 5 inches and press the Tab Key. 

 

 
 Click the Apply button. 

 
You can now see the transformation in the rectangle. In the same way you can 

transform any object using the control palette. 
 

 

RESIZING AN ELLIPSE 

In the exercise you will learn how to resize and ellipse. 
 

 Select the Pointer Tool. 
 
 

Click the ellipse drawn with the Pointer Tool and select it to display the sizing 
handles. 
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Click and drag handle shown to increase the height of the ellipse. 
 

CROPPING AN IMAGE 

Cropping trims away a portion of the graphic, rather than reducing the size of the 
graphic. In this exercise you will learn to Crop a Graphic. 

 Select the Cropping tool. 
 

Click the Graphic to select it and display the Sizing Handles. 
 

Click the handle shown and drag towards the center to crop the graphic. 
 

Now click on the center of the graphic, notice that the cropping tool changes to a 
hand tool. Hold down the mouse button and move the graphic downwards. 

 

WORKING WITH COLOURS 
 

ADDING COLOR TO A GRAPHIC SHAPE 
 

In this exercise you will learn to add Color to a Graphic Shape. 
 

 Select the Pointer Tool. 
 

Click the Polygon drawn on the Work area using the Pointer Tool to select it. 
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 Click Window menu. 
 

 Select Show Colors to open the Colors Palette. 
 

While the Outline of the Polygon is still selected, click the stroke Button. 
 

 
 Click Green color in the colors palette. 
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You can see that the Outline of the polygon is changed t Green color. To Fill the 
Polygon with yellow Color, Click the Fill button in the color Palette. 

 
 Click Yellow Color in the Color Palette. 

 
Now you can see that the Polygon is filled with Yellow Color. Click the Tint  

button to display the drop down tint list. 
 

Tint the fill Color to 55%by selecting it form the drop-down Tint list. 
 

 
In this way you can easily add color to the Squares, Rectangles, Ovals and Circles 

in PageMaker. 
 

WORKING WITH COLORS 
 

You can customize a color by using three color models i.e., RGB, HLS (hue, 
lightness, and saturation mode) and CMYK provided by Page-Maker. RGB is used to blend 
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percentages of red, green, and blue. HLS is used for increasing or decreasing the lightness and 
saturation of the hue as percentages of 100 to create the color. Using CMYK you can mix four 
primary colors cyan, magenta, yellow, and black in varying percentages of 100 to get different 
color combinations. All this can be done by selecting the new color icon at the bottom of the 
color palette or by selecting new color form the color palettes fly-out menu. 

 

 
CREATING AN RGB COLOR 

 
In this exercise, you will learn to create an RGB Color. 

 
 Click the Color Palettes fly-out menu. 

 
 Select New Color…Option. 
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The Color Options dialog box appears on the screen. Here you can see text boxes  
of three different Colors, and Slide bars to enter Values for Red, Green, and Blue. Enter “250”  
fro Red and press the Tab Key. Click the green dialog box. 

 

 
Enter “60” for Green and press the Tab Key. Click the blue dialog box. 
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Enter “160” for Blue and pres the Tab Key. 
 

 
You can see a preview on the Right-Hand side of the dialog box, showing the 

resulting color in the top half and the original color setting in the bottom half. Enter “Pink” in   
the name dialog box and press the Tab Key. 

 

 
Click OK. 

 
You can see that the name of the Color created is displayed in the Colors Palette 
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EDITING, COPYING, REMOVING AND REPLACING COLORS 

Editing: To edit a color, double-click on it in the colors palette. This opens  up 
the color options dialog box. In this box change the values for the color and in the Libraries list 
box select the matching system you like. Click OK. 

 
Copying: To copy a color from one document to other you can use Import Color 

option from the color palettes fly-out menu. 
 

Removing: To delete a color, select the color and use Delete option from colors 
palette’s fly-out menu. 

 
Replacing: To replace a color first you select the color you want to replace and 

choose color option from the colors palette fly-out menu then you change the name of the color  
to the exact name of the color you wish to replace it with and click OK. 

 

 

REPLACING COLORS 

In this exercise you will learn how to replace a color. 
 

 Select the “Red” Color in the Colors Palette. 
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 Click the Colors Palette fly-out menu. 
 

 Select Color options from the colors palette fly-out menu. 
 

Enter the name of the Color to the exact name of the Color you want to replace 
with. Enter “Green” in the Name dialog box and press the Tab Key. 

 

 
 Click OK. 

 
 A confirm dialog box appears on the screen. Click OK. 

 
Now you can see in the Colors palette that there is no  Red color option since all  

the items in Red are changed to Green Color. 
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GROUPING AND UN-GROUPING OBJECTS 
 

Grouping is usually used to create shapes by combining different shapes and for 
working on multiple objects at the same time. In this exercise you will learn to  group  the 
objects. 

 

 Click Edit menu. 
 

 Select the option “Select All”. 
 

Now you can see that both the Rectangle and Oval drawn on the Work area are 
selected. Click Element menu. 

 

 
 Select “Group” option. 

 
Now the objects are grouped and any change you make will modify both  the 

object. To check this you click the fill button in the colors palette. 
 

 Select Green color 
 

You can now see that both the objects are in Green color. To ungroup the objects 
you just have to go the elements menu and select “ungroup” options. 
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LOCKING OBJECTS 

You can lock individual objects in place in order to help preserve the design of  
your pages through all stages of production. You can change a color or fill applied to a locked 
object, but not its degree of rotation or its skewing angle. You cannot cut or delete a locked  
object without unlocking it first, but you can copy a locked object; it will be pasted as an 
unlocked object. The Apply button in the Control Palette appears gray when the selected  object 
is locked. The cursor changes to a lock icon when you try to move a locked item. 

 

 
Now point the cursor on the Circle and try to drag it. You won’t be able to move 

the object since it is locked. To Unlock the Object you just have to select “Unlock” option from 
Element menu. 
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MASKING OBJECTS 

Masking is a way of covering part of an object so that only a portion of it appears 
through a shape drawn with the rectangle, ellipse, or polygon tool. In this exercise you will learn 
how to mask objects. 

 
 Select the Pointer Tool. 

 
 Click the oval drawn on the work area using the Pointer Tool to select it. 

 

 Drag it and place it on the text, which is already there on the work area. 
 

 Select both the text and the object. To do this click Edit menu 
 

 Select “Select All”. Now you can see that both the text and the object are selected. 
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 Click the Element menu. 
 Select “Mask” option 

 
Click anywhere outside the object in the work area. 

 

 
 

You can now see that only the text inside the oval is visible and that around the 
oval has disappeared. Actually this command creates a window sort of effect to see the text 
through the graphic. You can also adjust what part of the text has to appear through  the object  
by moving the text with the Pointer Tool. 

  

 
 


